
HOW TO INSTALL: 

Make sure that your startup disk has no spaces or special 
characters in its name.
Move any old version of ffmpegX to the trash.

STEP 1.         Open the .dmg disk image and copy the 
ffmpegX 

 application to your Applications folder.
STEP 2.          Run ffmpegX from your Applications 
folder.

If you install ffmpegX for the first time, some Unix components will need installation in /Library/Application 
Support/ffmpegX. In such case, the self-installer window will appear telling you which components are going to be automatically installed. 
operation should be done only once or in case of major updates of the components. The mencoder, mplayer, mpeg2enc and reallib 
components are not included in the ffmpegX application itself to comply with applicable laws and licensing terms
download them first on your disk with a web browser, from the URL of their respective publishers indicated in the installer window
only the versions provided at the URL indicated in the installer window: if you install older or newer versions of the binaries, the application will not 
work. Read http://homepage.mac.com/major4/download.html for the installation instructions.

This version and further versions are only compatible with OSX 10.3 (Panther) and later. If you want to 
use ffmpegX with OSX 10.2 (Jaguar), please use the last 10.2-compatible version (0.0.9k) from 
http://homepage.mac.com/major4/ffmpegX_0.0.9k.dmg or 0.0.9h from 
http://homepage.mac.com/major4/ffmpegX_0.0.9h.dmg

READ THE ONLINE MANUAL : http://homepage.mac.com/major4/

If you want to receive an email when ffmpegX is updated, you may sign up to the ffmpegX 
announcement mailing list: http://homepage.mac.com/major4/mailing.html

___________________________________________________________________________
_____________________________________________________

Versions history

v0.0.9u r2 bugfix release Dec 4, 2005

- Improved handling of MOV/MP4 sources by mencoder MP4 H264, 
including audio normalization
- Improved handling of MOV/MP4 sources by iPod H264, including audio 
normalization
- Improved information gathering in the summary tab for MOV/MP4 files
- Improved handling of AAC sound in source movies
- Fixed incorrect aspect ratios in some presets
- Fixed additional minor bugs



v0.0.9u Dec 1, 2005

With this new version you are required to download a new version of the 
mencoder and mplayer binaries even if you already installed ffmpegX 
before. The download URL is written in the window which opens when you 
launch ffmpegX, please copy/paste it on a browser, download, unzip and 
install with "Install binaries" in the ffmpegX menu (which opens 
automatically at launch if you install ffmpegX for the first time). Only 
mplayer and mencoder need to be updated. Other versions will not work 
properly. Please read the installation instructions at 
http://homepage.mac.com/major4/download.html

- Added "iPod h.264" preset for super-fast (up to 7 times faster than 
other methods) video encoding for the video iPod. The preset uses 
320 width H.264 video and AAC audio. It encodes a feature movie into 
about 200MB.
- Added "iPod for TV" preset for super-fast video encoding for the 
video iPod, optimized for playback on TV in high resolution, 
through the audio/video output of the iPod. The preset uses 480 width 
mpeg-4 video and AAC audio, and It encodes a feature movie into about 
500MB. A maximum width of 720 may be used if your movie aspect is 
2.35:1, or 640 if it is 16:9. You may also use a width of 320 for iPod-only 
playback, and encoding much faster than h.264.
- Added x264 encoding engine for encoding to mpeg-4 h.264. Encoding
options are similar to mencoder h.264 and in addition the following 
options are available: Trellis quantization, i4x4 analysis, Decode with 
Quicktime, AVC level (1.3 for iPod, you may use 5.1 to match mencoder 
h264 default). Note that Quicktime is not quite compatible with b-frames 
so you may want to avoid them.
- Fixed further sound sync issues with mencoder h264.
- Disabled forced bitrate change when the image size is modified.
- Fixed bug with Author tool not taking into account text encoding and 
fonts when authoring selectable subtitles.
- Known issue: the current ffmpeg inverts the order of VOB audio tracks. 
So if you have 3 audio tracks numbered 0, 1 and 2, and the 2 should be 
italian, ffmpeg will find it in track 0 instead.

v0.0.9t r3 bugfix release Sep 10, 2005

- Fixed some sound sync issues with MP4 H264.
- Fixed bug with autocrop.
- Fixed bug when opening some mpg files with unavailable duration.
- Fixed bug with SVCD>DVD tool.
- Fixed bug with 3-pass encoding.
- r4 bugfix release: Fixed bug with NTSC encoding with ffmpeg mpeg-2.

v0.0.9t Aug 27, 2005

With this new version you are required to download a new version of the 



mencoder and mplayer binaries even if you already installed ffmpegX 
before. The download URL is written in the window which opens when you 
launch ffmpegX. Other versions will not work. Only mplayer and mencoder
need to be updated. Please read the installation instructions at 
http://homepage.mac.com/major4/download.html

- Added new MP4 H.264 quick preset for encoding with oustanding 
quality to the H.264 Advanced Video Codec (mpeg-4 part 10), and AAC 
sound, in a MP4 container fully compatible with Quicktime 7. 
Supports VIDEO_TS input and all mencoder features (subtitles, etc). Please
note: AVI h.264 has been discontinued, because it is highly unstandard to 
use H264 into AVI, and its previous availability was only experimental. 
Please note: PSP H.264 uses a non-standard muxing profile and will be 
added later to the available encoding formats.
- Added support of PSP non-standard resolutions (for use with 16:9 
sources): mainly 368x208, as well as 416x176, 320x176, 384x160,    
480x160 and 400x192. Note that the PSP screen has a resolution of 
480x272, but for movie playback, width x height must not exceed 76800 
pixels, so the smaller sizes listed above have to be used. Note that no 
matter the non-standard resolution used, the picture will be always scaled 
to the full 16:9 PSP screen size, so if your source is 2.35;1 you must prior 
reverse it to 16:9 by using black bars. For 4:3 sources, always use the 
standard 320x240 resolution. To gain a little quality if you don't mind for 
the bigger filesize, you may use a video bitrate of 400 kbps.
- Fixed display bug in ffmpegX Progress.
- The installer is now compatible with 10.4 Tiger.
- New "Tools" tab. Each tool has now its own view for easier operations 
and more room for additional options. 
- The "Open in Terminal Window" and "Keep Elementary Streams" 
option have been moved in the ffmpegX menu in the Apple bar. 
- The "Author as DVD/SVCD/VCD" and "Split in N chunks" options 
for ffmpeg and mpeg2enc post-processing have been moved in 
the Options tab.
- Prescanning of VIDEO_TS folders is now instantaneous.
- Added "ME Function" option for H.264 encoding. Sets the 
comparison function used for fullpixel motion estimation (affects quality). 
Available values: Diamond search (fastest), Hexagon search (default), 
Uneven multi-hexagon, Exhaustive search (very slow).
- Support for new source formats with newer versions of the binaries, 
including QT7 H.264, Ogg, Vorbis, VP3, FPS1, Theora, Alac.
- Added a smaller subtitle font size value of 0.
- Added simplified chinese subtitle font (STHeiti).
- Added new autosize values of 16:9, 1.85:1 and 2.35:1 "keeping 
horizontal size", allowing for the maximum possible quality in case of 
anamorphic 16:9 DVDs (eg. you'll keep all vertical resolution and increase 
width, instead of keeping width and decreasing horizontal resolution).
- Fixed encoding issues for some .rm files previously resulting in a bus 
error.
- Crop information is now included in user-saved presets.



- When manually editing the image width or height, 'best' bitrate is 
automatically re-computed.
- The "Fix" tool for doctoring AVI files now runs in the Progress window.
- Fixed preview for mpeg-2 encoding with 'Normalize' enabled.
- Fixed encoding to ffmpeg mpeg-2 with ntsc-film framerate (previously 
forcing ntsc).
- Some improvements to better support running on a japanese OSX.
- Fixed various bugs from 0.0.9s.
- Updated to mplayer/mencoder CVS of Aug 14, 2005.
- Updated to ffmpeg CVS of Aug 14, 2005.
- Updated to h.264 x264 rev285 of Aug 10, 2005.
- Updated to XviD CVS of Aug 10, 2005.

v0.0.9s Jan 23, 2005

With this new version you are required to download a new version of the 
mencoder and mplayer binaries even if you already installed ffmpegX 
before. The download URL is written in the window which opens when you 
launch ffmpegX. Other versions will not work. Only mplayer and mencoder
need to be updated. Please read the installation instructions at 
http://homepage.mac.com/major4/download.html

- The new ffmpegX opening view is the "Summary" tab. It provides 
a quick and easy way to operate ffmpegX by simply dropping a file on the 
left, choosing a preset on the right, and clicking "Encode". The source 
and target formats are detailed in the "LCD-like" screens.
- Added support of drag and drop of input files over the left "LCD" 
screen AND the Open.. field.
- Autocrop is now also supported with ffmpeg engine.
- Crop values are now always in TBLR format (top bottom left 
right) for both mencoder and ffmpeg engines. The needed 
conversions are now done internally and you do not longer need to 
convert between mencoder and ffmpeg crop formats.
- Autocrop now autocrops AND previews, for faster checking of crop values
(hit the Return key to stop the preview).
- Fixed bug which caused wrong cropping values in recent releases.
- Added normalize audio option in the audio tab. It analyzes the 
whole input audio track and automatically adjusts the volume for 
the best average value before encoding it, so as to avoid volume too 
low or clipping. Currently available with ffmpeg mpeg-2, ffmpeg mpeg-1, 
and mpeg2enc without "Decode with mplayer". (For mencoder engine 
DivX/XviD/h.264, you may still use the Audio "Gain" popup to manually 
adjust the encoded volume).
- Added setting of subtitle size (Filters tab), for burning subtitles in 
DivX/XviD/h.264/mpeg1/2 or for creating DVD selectable subtitles with the
specified font size. (Click the 'Play' button with a subtitle file loaded in the 
Filters tab to preview).
- Added setting of subtitle font (Filters tab), for burning subtitles in 
DivX/XviD/h.264/mpeg1/2 or for creating DVD selectable subtitles with the



specified font. Available fonts are a subset of the Apple fonts 
installed in OSX 10.3. Fonts for non-latin alphabets are available, 
like Chinese, Japanese, Cyrillic, Greek, etc. (Click the 'Play' button 
with a subtitle file loaded in the Filters tab to preview).
- Added setting of subtitle text encoding (Filters tab), for burning 
subtitles in DivX/XviD/h.264/mpeg1/2 or for creating DVD selectable 
subtitles. Allow to use subtitle files with non-english characters 
sets. More than 60 choices are available to cover almost all 
possible cases. (Click the 'Play' button with a subtitle file loaded in the 
Filters tab to preview).
- Added "PSP ffmpeg" quick preset to encode video suitable for 
playback on the Sony PSP. Sets the new "psp" ffmpeg profile. Please 
note that once converted to the special PSP profile, the files will be not 
readable by ffmpegX for converting back to another format. Also sets the 
particular file naming needed for PSP, and the name used internally to 
catalog the movies (to be entered in the "PSP name" field which will 
appear in the Options tab).
- Added support of TiVo .ty files input for encoding with mencoder 
engine (to DivX, XviD, h.264), and with mpeg2enc engine and "Decode 
with mplayer" enabled (to mpeg-1, mpeg-2), as well as playback with the 
"Play" button.
- Added support of TiVo .ty files demuxing with the "Demux" tool. 
Standard .m2v and .mp2 streams will be generated as output (you can 
then import them in DVDSP).
- Added support of TiVo .ty files "Author as DVD" with the "Author" 
tool, to directly author them as VIDEO_TS folders without any re-encoding 
(audio is automatically resampled to 48Khz and elementary streams are 
kept, for any further processing in Sizzle or DVDSP).
- Added b-frames option to mencoder h.264.
- When encoding sources with AAC audio to ffmpeg mpeg-2, you may now 
avoid known ffmpeg memory leaks in decoding AAC audio, by enabling 
the "Normalize" option (now default in the presets). By doing so, 
Quicktime will be used to decode the audio, while ffmpeg will still be used 
to decode the video.
- "Decode with mplayer" temp files are now created in the destination 
folder.
- Better support of Quicktime files for ffmpeg engine.
- Several bugfixes from 0.0.9r and better error handling.
- Updated to mencoder CVS of Jan 23, 2005 (static build). This version 
improves VOB subtitle displaying and also fixes a bug which made XviD 
files impossible to open on PC.
- Updated to ffmpeg CVS of Jan 6, 2005.
- Updated to h.264 x264 rev104 of Jan 23, 2005.
- Updated to XviD 1.1 CVS of Jan 23, 2005.

v0.0.9r Dec 25, 2004

- Added DVD selectable subtitles encoding support for ffmpeg and
mpeg2enc engine. Select a text-based subtitle file 



(.srt, .sub, .ssa, .smi, .rt, .txt, .aqt, .jss, .js formats are supported) in the 
Filters tab and encode your movie with DVD mpeg2enc (without the 
"Decode with mplayer" option) or with DVD ffmpeg quick preset. The 
subtitles will be imaged and embedded as fully selectable DVD 
subtitles by using the Subtitles button in your remote control (no 
more burning in the movie image, though you can still use burning mode 
by selecting "Burn" and "Decode with mplayer"). Use the "Play" button to 
check prior to encoding that the subtitle file is synchronized to your movie
(if you need to fix the subtitle syncing, use SubSyncX).
- Improved AUTHOR tool to add DVD selectable subtitles to an 
existing MPG file. Load a DVD-compliant MPG file and a text-based 
subtitle file (.srt, .sub, .ssa, .smi, .rt, .txt, .aqt, .jss, .js) in the first two 
Browse.. fields, then click AUTHOR. A VIDEO_TS folder will then be 
authored with the subtitles embedded as fully selectable DVD 
subtitles by using the Subtitles button in your remote control.
- Fixed 16:9 aspect ratio support when using manual letterboxing with 
ffmpeg engine.
- Added DVDImg tool to create a .dmg UDF image file for burning a DVD 
with Disk Utility. This tool requires as input (in the first browse.. field) a 
folder containing a /VIDEO_TS and /AUDIO_TS structure.
- In order to lower disk space requirements, a .dmg image file is no longer 
automatically created at the end of a DVD authoring process (only a /DVD/
folder containing /VIDEO_TS and /AUDIO_TS folders will be created). If you 
want to make a .dmg image for burning with Disk Utility, you may now use
the new DVDImg tool.
- Fixed bug which sometimes led to DVD authoring with audio in track 1 
instead of track 0.
- VIDEO_TS audio tracks and subtitles auto-detection does not delete 
other choices from the pulldown menus (it seems that this is needed for 
correct handling with some norwegian titles).
- Fixed some encoding issues with DivX 3, msmpeg4v1 and msmpeg4v2 
with ffmpeg engine.
- The Author tool now runs in the Progress window.
- Updated to ffmpeg CVS of Dec 18, 2004.

v0.0.9q Nov 21, 2004

- Updated mencoder and ffmpeg engines to to latest XviD 1.1 branch 
(about twice as faster than in version 0.0.9p).
- Updated H.264 codec to r.58 including many optimizations and 
improvements.
- Added 2-pass encoding option to H.264.
- Added encoding of RealVideo online streams for mencoder engine. You 
can now open as a source file a RealVideo .rpm or .ram metafile from your
disk, and be able to play and/or encode the online streaming video 
pointed by the metafile. Useful to encode news, trailers, etc. To create 
your own metafile, simply create a text file with a .rpm or .ram file 
extension, and write inside it the rtsp:// or http:// address of the .rm online
stream to be encoded (smil files not supported). Hint: you can create 



metafiles pointing to any kind of online files, not only RealVideo, eg. 
http://server.com/test.mpg is also valid).
- "DVD ffmpeg" quick preset now defaults without "Decode with 
Quicktime" for faster operation (ffmpeg muxer now compatible with DVD 
authoring).
- Added "Letterbox" sub-option to ffmpeg engine to disable auto-
letterboxing when "Decode with Quicktime" is used.
- "Best" bitrate is now automatically recalculated when selecting a quick 
preset (eg. switching from XviD to H.264 preset the bitrate will adjust 
automatically).
- Fixed issue in previous mencoder build resulting in incorrect subtitles 
display.
- "Invert mapping" can now select audio tracks other than 0.
- Choosing ffmpeg engine codecs now also sets keyframe interval 
automatically to 12 for mpeg-1/mpeg-2 and 240 for mpeg-4.
- Fixed wrong Progress message for XviD encoding.
- Fixed minor issues with "Passthrough audio" with ffmpeg engine.
- Fixed minor issues with subtitles number check from a VIDEO_TS folder.
- Updated to ffmpeg CVS of Nov 16, 2004.
- Added spanish localization (thanks Francisco de J. López V.)

v0.0.9p Sep 4, 2004

- Added H.264 quick preset for encoding with mencoder engine with the 
H.264 Advanced Video Codec (mpeg-4 part 10) through the library x.264 
(revision 46). Due to current limitations of mencoder, H.264 will be 
encoded in an AVI container with MP3 audio, instead of in an .MP4 
container with AAC audio as it should be. Support for MP4 container will be
added later. Use it to test this new codec, featuring superior performance 
and compression (40% smaller than mpeg-4, 60% smaller than mpeg-2).
- Added support for H.264 decoding for ffmpeg and mencoder engines.
- Added support for H.264 playback with the "Play" button through a 
patched mplayer binary. To playback the H.264 streams, click the "Play" 
button, then hit "F" to go fullscreen, SPACE to pause, RETURN to stop, and 
arrows to forward/rewind.
- Added "Use CABAC" option to H.264 encoding. Enables H.264 Context-
Adaptive Binary Arithmetic Coding to improve entropy coding and achieve 
smaller files (slower).
- Added "Full interframe analysis" option to H.264 encoding. Use all 
available inter-frame analysis methods (i4x4, psub8x8, psub16x16) for a 
better motion estimation (slower).
- Added "Constant bitrate" option to H.264 encoding. If enabled, encodes 
at the specified constant    bitrate by varying the quantizer between qmin 
and qmax. Please note that for H.264 the quantizer value has not the 
same meaning as in mpeg-1, mpeg-2 or mpeg-4. The quantizer range is 
from 2 to 51 on a logarithmic scale (so eg. the bitrate difference between 
q=20 and q=40 is only a factor of about 10). If "Constant bitrate" is 
disabled (default), then the qmin value is used to encode at constant 
quality, variable bitrate. A good range for qmin is 20..40 (default=22).



- Added support for built-in H.264 "Deblock" filter (in the Filters tab, 
enabled by default).
- Added "MPEG-TS" quick preset using ffmpeg engine, to encode to .TS 
DVB transport stream format using the ffmpeg mpeg-2 codec and MP2 
sound (experimental).
- Added support of raw .DV video input for mencoder DivX/XviD and 
vcd/svcd/dvd with "decode with mplayer".
- Added playback of raw .DV video files with the "Play" button.
- Added support of AAC sound input in Quicktime .MOV files.
- Added support of AC3 stereo encoding in mencoder DivX and XviD 
(before it was just passing through a source AC3 -use 'Passthrough' audio 
codec to do that now-).
- mencoder DivX/XviD deinterlace filter now use median deinterlacer 
instead of linear blend, for better quality.
- Added "Decode with Quicktime" support for ffmpeg engine AVI encoding 
(XviD, DivX). Now used by default with ffmpeg AVI encoding when the 
input file is a Quicktime .mov file, thus fixing previous issues with MOV 
input (enables auto-letterboxing).
- The DVD>DVD4 tool can now also process VOB files smaller than 4GB, 
by applying a VOB to VIDEO_TS conversion without any recompression (1 
or 2 audio tracks retained). Disable "Keep elementary streams" if you 
want to remove intermediate files.
- Further dual processor optimizations to mencoder mpeg-4 encoding.
- Renamed quick preset names as "format name" followed by "(engine 
name)".

v0.0.9o Aug 21, 2004

- The "Save as.." default destination is now automatically set by 
appending ".ff." to the source. Eg. if you open "/Movies/a.mov", the "Save 
as.." path when encoding to avi will be set to "/Movies/a.mov.ff.avi". If the 
source is a VIDEO_TS folder, then the generic destination filename 
"movie" will be used by default.
- Added "MP4" quick preset using ffmpeg engine, to encode to .MP4 
format using the libavc mpeg4 codec and AAC sound (you can also 
use .MP4 .XviD instead of .MP4 libavc mpeg4).
- Added video encoding to .MP4 libavc mpeg-4 with ffmpeg engine.
- Added video encoding to .MP4 XviD with ffmpeg engine.
- Added "fixed quantizer mode" for mencoder XviD, to achieve constant 
quality XviD encoding. To use it, set qmin=qmax (lower values mean 
better quality, use 2 or 3 for max. quality). The encoding will take place in 
constant quality and variable bitrate (instead of constant bitrate and 
variable quality). The bitrate value will be ignored, so the bitrate 
calculator should not be used. When encoding in fixed quantizer mode, 
the final file size will depend on the movie complexity and is not 
predictable. Please note that 2-pass disables constant quantizer mode.
- Added "Cartoon content" option to mencoder XviD, which sets internal 
thresholds in order to take better decisions on motion vectors and improve
quality on flat-looking cartoon or anime.



- Added Trellis quantization option to mencoder XviD and ffmpeg engines.
- Added Quarter Pixel motion compensation option to ffmpeg engine.
- Fixed an issue with 3GP encoding from 0.0.9n.
- Fixed mencoder AVI compatibility with Quicktime Player for files bigger 
than 1GB (please remember that AVI 1.0 files must be smaller than 2GB).
- Subtitles popup-menu range is now 0-31.
- Updated to ffmpeg CVS of Aug 21, 2004.

v0.0.9n Aug 3, 2004

- Added video encoding to MOV mpeg-4 (libavc) with ffmpeg engine.
- Added video encoding to MOV XviD with ffmpeg engine.
- Added audio encoding to AAC with ffmpeg engine for use with MOV or 
3GP encoding.
- added "MOV mpeg-4" quick preset using ffmpeg engine, to encode to 
Quicktime .mov format using the libavc mpeg-4 codec and AAC sound.

• This preset allows you to encode with the speed of ffmpeg, the 
quality of the libavc mpeg4 codec, and to read and edit the 
resulting .mov files natively in Quicktime Player and other Quicktime 
applications like Final Cut Pro, even without installing additional DivX 
codecs.

• All usual ffmpeg options like "High quality", "Two pass", "b-frames", 
and quantizers are enabled.

• You can also use "MOV XviD" instead of "MOV mpeg-4".
• Attention, the MOV format may not be playable on PCs or DivX-

hardware players, so for such compatibility you must use AVI mpeg-
4.

• To edit in Final Cut Pro without need of rendering, encode with the 
option "Use only I-frames" (big files, use the bitrate calculator "Best" 
button to set bitrate) and set the "mpeg-4" codec in the timeline 
settings of Final Cut.

• This preset uses a small Keyframe interval of 12 in order to improve 
seeking in Quicktime applications.

• Use this preset to convert your mpeg/vob files to an editable 
format with a small file size, so as to edit them, or archive them 
without needing terabytes of storage.

• Use this preset to convert your big .DV captures into very 
small, and still editable files (enable "Deinterlace" when 
converting .dv files).

• Use this preset if you don't need PC/DivX hardware players 
compatibility and prefer to keep your movies in a Quicktime MOV 
container and play them back with Quicktime, taking advantage of 
all Quicktime features and Quicktime-based applications.

- Faster ffmpeg engine encoding on biprocessor machines.
- The bitrate calculator now takes into account the "Use only I-frames" 
ffmpeg mpeg-4 option.
- "Decode with mplayer" temporary data (stream.yuv and 
audiodump.wav) are now stored in the current home folder, in order to 
avoid permission problems.



- Restored "Hide ffmpegX" choice in the menu which was disabled in the 
previous version.
- Some minor updates to ffmpegX Progress.
- Updated to ffmpeg CVS of July 30, 2004.

v0.0.9m Jul 18, 2004

- Added video encoding to XviD format with ffmpeg engine.
- Added "fast XviD" quick preset using ffmpeg engine, up to 300% faster 
than mencoder XviD.
- Updated XviD to version 1.0.1 (fixing problem of green artefacts on the 
left side of the screen).
- Added video encoding to DV format with ffmpeg engine.
- Added audio encoding to PCM-16 bit (for use with DV video).
- Added "DV" quick preset to encode to DV video PAL or NTSC. (Always 
open the source file first, then select the quick preset without changing 
the settings: don't change the image size and don't use the bitrate 
calculator to change bitrate when encoding to DV format, as DV implies 
standardized settings).
- New stabler and optimized mencoder and mplayer builds including latest
libavcodec.
- Added "Install binaries" choice in the ffmpegX menu to call back the self-
installer sheet at any time.
- ffmpegX no longer installs its components into shared Unix directories 
/usr/bin or /usr/local/lib. External components are now automatically 
stored into a private /Library/Application Support/ffmpegX/ directory.
- External components have been further optimized.
- Added various improvements to the self-installer. The admin password is 
now entered in hidden mode.
- Updated to ffmpeg CVS of July 18, 2004.

v0.0.9L Jun 19, 2004

This version and further versions are only compatible with OSX 10.3 
(Panther) and later. If you want to use ffmpegX with OSX 10.2 (Jaguar), 
please use the last 10.2-compatible version (0.0.9k) from 
http://homepage.mac.com/major4/ffmpegX_0.0.9k.dmg. With this new 
version you are required to download a new version of the binaries even if
you already installed ffmpegX before. The download URL is written in the 
window which opens when you launch ffmpegX. Only the specified version
of the binaries is supported and other versions will not work.

- Added support for mencoder and mplayer binaries version of June 16, 
2004.
- mencoder now includes Linux reallib libraries allowing to open all 
realvideo formats for encoding to mencoder mpeg-4, XviD, mpeg-1/mpeg-
2 (with 'Decode with mplayer' enabled).
- Updated XviD libraries to version 1.0.1.
- New options available for XviD encoding: "High quality", "Use b-frames", 



"Quarter Pixel ME (qpel)", "Print PSNR", "Interlaced content".
- You can now burn .srt or .sub subtitles when encoding in DivX and XviD 
format.
- XviD encoding is now fully compatible with 'smartmovie' videoplayer (for
use in handheld devices and smart phones).
- Added fixes to "Extract" button to extract subtitles in VobSub format.
- An error is now reported when there are spaces in filenames while using 
'Decode with mplayer'.

v0.0.9k Jun 13, 2004

- Prescan of mpg and vob files at the start of the encoding is now super-
fast.
- Fixed issue of quick framerate when encoding Quicktime files (eg. DV 
files) to "fast DivX".
- Autocrop will now take into account the "Autosize" aspect ratio value to 
set the aspect ratio of the cropped image (usually 2.35:1, 16:9 or 4:3).
- Added video encoding to .3GP H263 format.
- Added audio encoding to AMR Narrowband format.
- Added "3gp" quick preset to encode video optimized for playback on 
smart phones and handheld devices compatibles with this format. The 
preset uses a .3gp container with h263 video in qcif resolution at 30 kbps, 
and AMR-NR audio at 12 kbps, allowing for a whole movie to fit in less 
than 30MB. Depending on the specifications and memory available in your
playback device, you should adjust settings to obtain the best image 
quality, then save a ffmpegX preset file with your optimized settings. If 
you use Bluetooth, the Apple Bluetooth File Exchange application will 
allow you to easily send the encoded .3gp file to your device. Note: some 
phones could need installation of a video player software in order to play 
3gp files (see the website of your phone brand to check). Note: video for 
phones using the "Smartmovie" player can be encoded by simply using 
the DivX/XviD codecs with appropriate size and bitrates (save a preset file 
when you found the best settings for your phone).
- Added low audio sampling rates support with mencoder engine.
- Added fixes to the VOB demux tool.

v0.0.9j May 31, 2004

- Opening a video or audio file now also set the "Duration" field in the 
Video tab to its duration in minutes (duration is recognized for all formats 
excepted VIDEO_TS, mpv, m1v and m2v).
- The Pulldown tool now runs in the Progress window.
- Fixed "aspect ratio error" in some cases of VCD encoding in NTSC format.

v0.0.9i May 22, 2004

- Added "AVI with 2 audio tracks" Mux as.. option. To use it, select an AVI 
file and an audio file in the Tools tab, and click Mux as.. "AVI +audio". You 
will obtain an AVI file with the existing audio track/s, and the additional 



audio. If the audio track is not mp3, then it will be automatically converted
to mp3 before muxing (conversion will take about 30-40 minutes in that 
case). Use this tool to build AVI DivX/XviD files with multiple languages 
audio tracks. Use VLC to play AVI files with two audio tracks.
- Added self-installer inside the ffmpegX application. To install ffmpegX, 
you should now simply move the ffmpegX application from the disk image 
to your Applications folder. On launch, ffmpegX will automatically detect 
whether your system need installation of any additional components and 
list them in the self-installer window. You should then simply click "Install" 
once to install them.

v0.0.9h May 8, 2004

- Added "Pulldown" tool. It adds 3:2 pulldown flags to .m2v elementary 
mpeg-2 streams encoded in NTSC FILM format with ffmpeg engine, so as 
they can be opened in DVD Studio Pro 2. Please note that mpeg2enc 
engine already supports 3:2 pulldown.
- Fixed crash when opening very large DV files. To convert a very large DV 
file to DivX, always use the "fast DivX" preset.
- Faster prescan analysis when opening a file.
- Fixed issues with DVD>DVD4 when output was slightly bigger than 4GB 
if keeping two audio tracks.

v0.0.9g May 2, 2004

- All DVD presets, including DVD hi-bitrate and DVD lo-bitrate now support 
AC3 5.1 sound encoding.
- "Decode with Quicktime" option now also decodes MPG audio tracks.
- mp2 encoding for VCD/SVCD/DVD presets is now super-fast.
- Improved "fast SVCD" encoding.
- Added manual "letterbox" settings for ffmpeg engine (Filters tab), 
enabling addition of black padding areas at Top/Bottom/Left/Right (values 
in pixels). To correctly use this feature, you should first reduce the image 
size depending on the source aspect ratio, then add black areas to match 
to playback aspect ratio. (Pleate note: When "Decode with Quicktime" is 
used, auto-letterboxing is always enabled and will overrid the manual 
settings.
- Updated to ffmpeg CVS of Apr 30, 2004.

v0.0.9f Apr 25, 2004

- Added support of two audio tracks for SVCD, CVD and DVD muxing with 
the "Mux as.." tool. An additional input field has been added in the tools 
view to select the second audio track in mp2 or ac3 format (other formats 
being automatically converted to mp2).
- Added support of two audio tracks in DVD>DVD4 tool (both must be in 
ac3 format). Proceed by selecting as input file a VOB with two audio tracks
and no subtitle track, then select the audio track numbers with the two 
pulldown menus located next to the DVD>DVD4 button. To include one 



audio track only, select "No" in the second pulldown menu.
- "Auto" split handling moved at muxing time instead of encoding time, for
compatibility with two audio tracks support.
- Fixed "fast DVD" issue resulting in 0k ac3 files.

v0.0.9e Apr 12, 2004

- The "Mux as.." tool now also supports AVI muxing. It will combine an AVI 
file video track with a mp3 or ac3 audio file (wav, mp2 and other formats 
being automatically converted to mp3).

v0.0.9d Apr 12, 2004

- The "Demux" tool now also supports VOB demuxing. It will extract from a
VOB its m2v video file and ac3 audio files (for now only ac3 audio is 
extracted). This is also useful to convert VOB to VIDEO_TS (demux the 
VOB into m2v and ac3, then run them into "Mux as..DVD", with "Author as 
DVD" enabled).
- Improved all "fast" presets (fast SVCD, fast DVD, fast VCD, fast DivX).
- Save/load presets take now into account the new "fast" settings.

v0.0.9c Apr 6, 2004

- Added "fast SVCD" and "fast DVD" quick presets for super-fast SVCD and 
DVD encoding (twice as fast as SVCD and DVD presets).
- "fast DVD" preset supports encoding of audio to AC3 format.
- Added "Decode with Quicktime" option to ffmpeg engine encoding 
options (for mpeg-1 and mpeg-2 encoding). It enables letterboxing and
Quicktime codecs input support to fast VCD, fast SVCD and fast DVD quick
presets. Elementary streams are also created. Splitting in "auto" 
chunks and authoring is also supported.
- Fixed some bugs from 0.0.9b.
- Updated to ffmpeg CVS of Apr 2, 2004.

v0.0.9b Mar 28, 2004

- Added "Decode with mplayer" support for VCD & mpeg-1 encoding (it 
was previously limited to mpeg-2 formats like SVCD and DVD), thus 
allowing VIDEO_TS input and subtitle burning for VCD and KVCD encoding.
- Added Quick Presets for encoding audio to AC3 (compatible with DVDSP 
2).
- Added 5:1 channels choice for AC3 encoding (in addition to Stereo and 
Mono).
- Fixed "%" muxing bug when encoding to DVD.
- Fixed deinterlacing with XviD format (no more green stripes).
- Quick Presets now also sets default media size for correct auto-split 
behavior (80 min mode-2 for VCD/SVCD, 80 min mode-1 for DivX/XviD and
DVD 4GB for DVD).
- Fixed other minor bugs from 0.0.9a.



- Updated to ffmpeg CVS of Mar 22, 2004.

v0.0.9a Oct 12, 2003

- Intelligent automatic settings now also set image aspect ratio based on 
source, and optimized videobitrate for encoding with current codec.
- Autocrop now also adjusts videobitrate based on new image size and 
ratio.
- DivX Quick presets no longer set image size (to keep automatic size set 
from source, or image size set by "Auto" bitrate calculator).
- Fixed KVCD muxer.
- Fixed some buffer underflow issues for XVCD and XSVCD "Mux as" tool.
- Fixed again encoding of VOB with PCM sound (was not working in 0.0.9). 
- Fixed file extensions for audio encoding.
- Added italian localization by Gabriele Callari (now the application is 
localized in english, french, german, and italian).

v0.0.9 Oct 6, 2003

- Intelligent automatic setting of NTSC/PAL framerate, image size 
and pulldown mode, depending on source movie analysis. This will 
greatly simplify the operating process: just selecting a quick preset should
now be enough.
For example to encode an avi DivX file to SVCD, all you have to do is now 
just: 

- drop the source file onto the application icon (or open it with 
the Open... button), 

- select SVCD quick preset,
- hit encode.

For example to encode a VIDEO_TS folder to XviD, all you have to do is 
now just:

- drop the VIDEO_TS folder onto the application icon, 
- select XviD quick preset,
- hit encode.

- New "Information" line at the top of the window. It will always read in this
format:
VIDEO: DivX, size:480x576, NTSC FILM (23.976) w/3:2 pulldown, 
7500 kbps - AUDIO: mp3, 44100Hz, 96 kbps. The information is 
selectable so as you can also copy/paste it.
- There are no longer PAL and NTSC versions of each Quick preset and of 
each "autosize" image format. PAL/NTSC image size mode is now set 
automatically based on the current framerate.
- Added new default postprocessing split in "Auto" chunks mode for 
mpeg2enc encoding and for the mux as.. tool (will be implemented later 
for ffmpeg encoding), which will cut the stream as needed when CD 
media size is exceeded (as specified in the bitrate calculator CD media 
type popup: eg. "80 min mode-2", "74 min mode-1", etc, OR (whichever is 
smaller) as specified by a size in MB as manually entered in the size field 
of the bitrate calculator, eg. "100 MB"). Authoring to VCD or SVCD can be 



automatically applied to resulting chunks.
- Operating mode of "Decode with Quicktime" (for 
VCD/SVCD/CVD/DVD/KVCD/KDVD encoding) is now exteded to any input 
formats (it was limited to Quicktime .mov files and VOB files before). Eg. 
if your input file is an .avi DivX file, Quicktime decoding will now also 
apply, and you will no longer need to use DivX Doctor II. When using 
"Decode with Quicktime" you must make sure that your input file can be 
opened in Quicktime Player, or the encoding will fail (eg. you must have 
the codecs to read it, like divx.com and 3ivx.com codecs to read .avi DivX,
or QT mpeg-2 player codec to read VOB files). If you don't want to decode 
with Quicktime or don't have codecs for a specific format, disable "Decode
with Quicktime" in the Options tab, so as ffmpeg will be used to read the 
source, or enable "Decode with mplayer", so as mplayer will be used to 
read the source.
- Improved "fast-mpeg1" preset for VCD encoding. Encoding options,
muxing process, splitting process and authoring process have been 
optimized to improve DVD player compliance. Please note that "fast-
mpeg1" ffmpeg engine always encodes in variable bitrate mode, which is 
non-standard for VCD, so some players will not handle such streams. But if
your player accepts them, consider preferring this mode for VCD 
encoding, as this is one of the fastest and best quality mpeg-1 encoders 
currently available on all platforms.
- File extension is automatically added at encoding time to the 
destination filename if it is missing or wrong (eg .mpg, .avi).
- Destination field is automatically set by default with the same 
path as the source field.
- Source file field is no longer editable in order to enforce autoscanning 
requirements on selected source. To open a source file, you now need 
either to drag and drop its icon to the application icon, or click "Open.." to 
locate it. The source field is still selectable, so you can copy and paste its 
contents.
- More bugfixes from 0.0.8d.
- Proofreading of german localization by Andreas Gfeller.

v0.0.8d Sep 20, 2003

- Build 0.0.8d∆ recompiled on OSX 10.2.6 fixing an issue on some systems
where the application would crash by clicking "Open" or interface tabs.
- Fixed "Error 1" appearing in some situations when encoding a VIDEO_TS 
folder.
- Fixed bug of 0.0.8c preventing encoding with "audio only" quick presets.
- Fixed updating file info and VIDEO_TS audio tracks and subtitles when 
drag and dropping the source file to the application icon.
- Postprocessing and authoring as DVD also uses dvdauthor instead of 
ifogen/tocgen like the Author tool / for better compliance and proper 
handling of AC3 audio tracks.
- Various error handling improvements.

v0.0.8c Sep 14, 2003



- The superfast DVD > DVD4GB tool now takes into account the "Keep 
elementary streams" checkbox, letting you retrieve the compressed .m2v 
and .ac3 elementary streams (useful if you want to author in DVD Studio 
Pro or Sizzle and add chapter markers or other audio tracks / subtitles 
before mastering).
- Renumbered the 'audio track' popup menu of the DVD > DVD4GB tool so
as to match 0SEx audio track numbering.
- Fixed bug preventing automatic authoring to .bin/.cue when creating a 
VCD with mpeg2enc engine.
- Merged the four installers into a single installer package.
- Added french localization (thanks Michel Pansanel, Antoine Préveaux, 
Donald, fraxx).
- Added german localization (thanks Matthias Unterhuber, Gerritt van 
Aaken and David Dauer)

v0.0.8b Sep 6, 2003

- Added super-fast DVD > DVD4GB compression tool (registered version). 
Twice as fast than dvd2one, it uses the M2VRequantiser engine (with kind 
authorization from Metakine.com), achieving compression of a VOB file 
larger than 4GB into 4GB without reencoding. To use this tool, simply 
choose the non-encrypted source VOB file in the first Browse.. field, select 
the AC3 audio track number to keep in the pulldown menu, and click the 
DVD > DVD4 button. The output of this tool is a DVD folder ready to burn 
with Toast in DVD mode. For now only AC3 audio tracks are supported. (If 
you select a non-existent audio track or a track which is not in AC3 format,
the process will stop with the error "Unable to read filename.ac3").
- The "Mux as.." and "Author" tools now use dvdauthor instead of 
ifogen/tocgen for better compliance of VIDEO_TS folders and proper 
handling of AC3 audio tracks.

v0.0.8a Sep 3, 2003

- Added KVCD, KSVCD and KDVD presets. See kvcd.net for more 
information about kvcd. These formats allow to store more video on a 
single CD with good quality, than their VCD/SVCD/DVD counterparts.

You can store on a 700MB CDR media about:

VCD: 80 min of video at near-VHS quality
CVD: 52 min of video at near-SVHS quality
SVCD; 45 min of video at near-DVD quality
KSVCD: 63 min of video at near-SVCD quality
KVCD: 108 min of video at near-VCD quality

You can store on a 4GB DVD media about:

DVD-hi 145 minutes of video at DVD quality



DVD-lo 4 hours and 10 min of video at near SVCD quality
KDVD: 5 hours of video at near SVCD quality

Note: the option "Use mplayer to decode" is not currently supported for 
kvcd presets.
- Support of drag and drop of input files over the application icon.
- Fixed a bug of 0.0.8 displaying incorrect aspect ratios when selecting 
some Quick presets.

v0.0.8 Sep 1, 2003

- Processing is now launched in the "ffmpegX Progress" Cocoa ObjC 
window (thanks Johan Lindström). (The "Open Terminal window" checkbox 
in the Tools tab still allows to switch to Terminal mode if you prefer it). The 
Progress window list includes, for each process, a progress bar, a cancel 
button and a "more info" button. The "more info" button opens a window 
for advanced users including the command line and the process output. 
The output is colorized in red for errors, orange for warnings and blue for 
useful information. The processes are queued in the list and will start as 
soon as the preceding process finish or fails. Waiting processes can be 
started manually with the "Start now" button (don't run concurrenty 
multiple 3-pass encodings or "mplayer decode" processes). A done or fail 
sound effect is played at the end of each process. When a process is done,
a "reveal in Finder" button appears to locate the encoded file in the Finder.
The "Clear" button at the bottom of the Progress window cancels finished 
processes from the list. 
- Added "Save presets" and "Load presets" in the File menu.
- Added drag and drop of preset files and input files on the application 
icon.
- ffmpeg engine now supports experimental "fast mpeg-2" encoding (CVS 
of Aug 26, 2003). Source must be mpg or avi (not vob for now). This new 
encoder comes with 2-pass support and VBR like the "fast mpeg-1" and is 
quite fast (almost realtime on a G4 667). However, the muxer is not quite 
compliant and the output should be still considered experimental. For 
example, SVCD cannot be created. It seem possible to build a    compliant 
DVD by demuxing the stream and then remuxing the .m2v file with the 
source audio, by using the Tool "Mux as.. DVD" (and "Author as DVD" 
checkbox enabled in order to generate the VIDEO_TS folder).
- Added Calc "auto" button (thanks Donald for suggesting). After entering 
the movie duration and the media size (as number of CDs or as a value in 
MB), clicking this button will automatically set:

• a bitrate suited to fill such media,
• as well as an image size suited to such bitrate for best bpp 

quality.
The audio bitrate is also taken into account as set in the audio tab. 
Remember that if the resulting horizontal image size is lower than 480 you
will obtain less than SVCD quality, and if it is lower than 240 you will 
obtain less than VCD quality, so in such cases you should consider to 
increase the media size (eg use two CDs instead of a single one). You 



should also never encode to a size greater than the source image size.    
This button is meant for mpeg-4 based formats only (DivX, XviD). Don't 
use it for mpeg-2 based formats (VCD, CVD, SVCD, DVD) as the image size
for these must be the standard one.
- The 'Check audio' button has been removed. When opening a VIDEO_TS 
file, the list of available audio streams is now automatically shown in the 
audio track popup menu.
- The 'Check subtitles' button has been removed. When opening a 
VIDEO_TS file, the list of available subtitle languages is now automatically 
shown in the subtitles popup menu.
- Encoding of VOBs with PCM audio should now work correctly.
- Added mencoder mp3 audio encoding mode values of CBR (constant 
bitrate, default), ABR (average bitrate) and VBR (variable bitrate, uses the
optimal q=2 quantization level). (Not available for mp2 encoding or 
ffmpeg engine).
- The Autocrop button now also automatically sets the encoding image 
size equal and the cropped image aspect ratio, so as any resize will keep 
the good image aspect. If you don't resize you'll automatically use the 
source size. If the cropped image has a non-standard aspect, it will be 
rounded to the nearest aspect ratio in the Autosize list.
- The autocrop is no longer limited to registered users.
- Added new "autosize" aspect ratio of 1.85:1 (Panoramic) (thanks 
FredMic).
- A new tool has been added for registered users (this is the only limitation
of version 0.0.8 non-registered version; please register ffmpegX if you find
it useful, so as you will support my effort to make it better and better):    
"S/VCD to DVD". Like the program svcd2dvd on PC, it's a one-click tool to 
remux, resample and reauthor without re-encoding a SVCD or VCD .mpg 
file (or .bin image, auto-ripping the sequence from it) (or a folder 
containing many of them, in auto-batch mode; you can even mix VCD, 
CVDs and SVCDs .mpgs or .bins in the same folder) into a /DVD/ folder 
ready for burning in Toast DVD mode. The audio is automatically 
resampled at 48000 Hz. Please note that the image size of SVCD video is 
not DVD compliant and will not be accepted by about 30% of players. 
Check dvdrhelp.com compatibility list to see if your player can play "dvd-
vcd" or "dvd-svcd". To use this tool, just select the file to be converted in 
the first "Browse" field (or if you have many files to convert, as it will be 
often the case, put them in a folder and select the folder), then click the 
tool button and you're done. Preview the resulting VIDEO_TS folder with 
the ffmpegX "Play" button. Burn the resulting /DVD/ folder with Toast in 
DVD mode. (Make sure you have enough disk space to hold twice the size 
of your source mpegs before running this tool).
- Improved support of spaces and special characters like $&"'*(){}
[]|;<>`?!~\ in filenames and path names.
- Added "Closed GOP" mpeg-2 option to create only closed group of 
pictures that can be decoded without reference to their
predecessor.    This is useful for streams that are supposed to be used in 
multi-angle DVD's and in some authoring applications like DVD Studio Pro.
- Added "Q Matrix" mpeg-2 option (need mpeg2enc binaries compiled 



from CVS of Aug 28, 2003) to set a custom quantization matrix instead of 
the default one, for perceptual-optimized compression modes. Available 
values are "High frequencies" (replaces the old "Encode hi freq" option, to 
encode as much high frequency information as possible from high quality 
sources), "kvcd" (will use kvcd.net "Notch" Quantization Matrix, allowing 
for 16% average bitrate reduction in VBR mode), "tmpgenc" (will use 
tmpgenc standard quantization matrix, allowing for 10% average bitrate 
reduction in VBR mode).
- Added back the "Black & White" option to reduce noise on black & white 
encodings.
- The information displayed at the top when opening a file is now also 
provided when selecting VIDEO_TS folders.
- The "Info" tool now reads .ts (mpeg transport stream) and .asf files.
- Multiple mencoder 2-pass encodings can now be launched at the same 
time.
- Various fixes, gui improvements, better error handling.
- Tested on OSX 10.2.6 and OSX 10.3 (7B44).
- Please address any bugs reports and localization requests to 
major4@mac.com

v0.0.7d Jun 21, 2003

- Added new "Calc img" button to calculate image size suited to current 
bitrate (bits per pixels) (never use an image size larger than source image 
size, or larger than your video playback device image size).
- Added new "Calc size" button to calculate encoded file size from 
specified bitrate and duration.
- Checking audio and subtitles in a VIDEO_TS folder now checks within 
specified title.
- Added new link in the engines installer to ffmpegxbinaries.sit mencoder 
and mplayer stablest binaries recommended for ffmpegX. Note: don't use 
version of June 20 of mplayer or mencoder, they still have many bugs.

v0.0.7c Jun 18, 2003

- Added new auto-colorize feature of video bitrate value. When using the 
bitrate calculator, or entering a value in the video bitrate field, ffmpegX 
will check automatically if the value is in a 'safe' quality range depending 
on current image size and framerate, and colorize the value accordingly. 

Red=the bitrate is too low for the selected image size, if you 
use it you'll be compressing your movie too much and the quality will not 
be acceptable with the current image size (consider choosing another 
bitrate, or use a smaller size); 

Green=this bitrate is quite good, if you choose it you'll obtain 
good quality for the current image size; 

Blue=this bitrate is too high, if you choose it you will not 
improve quality comparing to "green" values and you'll be wasting space 



on your disks (consider choosing another bitrate, or use a larger image 
size, though not larger than the source image size).
- Changed black color code to blue on 3-pass encoding window, according 
to above feature.
- Default values for mpeg-4 encoding now set to NTSC FILM and 2.35:1 
aspect ratio (supposing you will use cropping).
- Engines installer points to a new, stablest version for the mplayer binary 
(mencoder and mpeg2enc unchanged).

v0.0.7b FR Jun 14, 2003

- French localization now available for download from 
http://homepage.mac.com/major4/download.html
Translation by Michel Pansanel, Antoine Préveaux and Donald. Proof-
reading by fraxx.

v0.0.7b Jun 7, 2003

- Added "3-pass encoding" option for mencoder mpeg-4 (in the Options 
tab), leading to better control of the encoded movie final size. The 1st 
pass will encode audio and calculate the video bitrate (1st pass duration is
about 1h30 on a G4 for an average movie). You will be then prompted for 
choosing a video bitrate amongst suggested options to fit in one or two 
CDs. 2nd pass and 3rd pass will encode the video. Note that only MP3 
audio is supported for 3-pass. The suggested bitrates appear either in red,
green or black (blue) color, which mean: 

red=this bitrate is too low for the selected image size, if you 
choose it you'll be compressing your movie too much and the quality will 
not be acceptable with the current image size (consider choosing another 
bitrate, or use a smaller size); 

green=this bitrate is quite good, if you choose it you'll obtain 
good quality for the current image size; 

black (blue)=this bitrate is too high, if you choose it you will 
not improve quality comparing to "green" values and you'll be wasting 
space on your disks (consider choosing another bitrate, or use a larger 
image size, though not larger than the source image size).
- Fixed "pel_aspect_ratio" error with .avi to mpeg-1 NTSC, and other 
bugfixes.

v0.0.7a Jun 7, 2003

- Fixed a bug on .avi to mpeg-1 or mpeg-2 process causing a "no 
framerate specified" error.
- Added better error handling and error alerts for some features.



v0.0.7 Jun 1, 2003

- Added "Trellis quantization" and "Qpel" encoding options for mencoder 
mpeg-4. Use them for even more encoding quality (slower).
- Added "ME function" pulldown menu for mencoder mpeg-4. Sets the 
comparison function used for motion estimation (affects quality). 
SAD=Sum of Absolute Differences (fastest, default), SSE (Sum of Squared 
Errors (better quality, fast), SATD (Sum of Absolute Hadamard 
Transformed Differences) (a bit better than SSE, slow), RD (Rate Distortion
optimal, best quality, very slow).
- Added "Print PSNR" option for mencoder mpeg-4. Prints the peak signal 
to noise ratio for the whole video after encoding, and stores the per-frame 
PSNR in "psnr_hhmmss.log". For ffmpeg codecs, only the per-frame PSNR 
is returned while encoding. Returned values are in decibel, the higher the 
better. This gives a good indication of the encoding quality which is being 
achieved. Use in combination with "5 seconds test clip" to quickly 
evaluate which encoding options will give the best quality and which fps 
you'll obtain with, so as to decide the better quality/speed tradeoff.
- Added new "Filters" tab. All filters, image crop & subtitling options are 
now located in this tab.
- Added "Preview" button in the "Filters" tab to preview the source movie 
starting from the "Checkpoint" min:sec position, simulating the crop area 
with a white-border rectangle in the picture, rendering the subtitles, 
adding filters (excepted mpeg-2 filters), and playing the selected audio 
track. Use it to test settings before encoding.
- Added "Denoise" filter to mencoder mpeg-4 and XviD (3d denoiser) 
(slow, don't use if source has no visible noise). Use "Preview" to check its 
effect.
- Added "Dering" and "Deblock" filters to mencoder mpeg-4 and XviD to 
reduce artifacts from source video (slow, don't use if source has no visible 
artifacts). You can also use "preview" to check their effect.
- Added "Brightness" and "Contrast" controls to mencoder mencoder 
mpeg-4 & XviD. You can also use "preview" to check their effect.
- Moved mpeg-2 Luminance, Saturation and Sharpness controls in the 
filters tab.
- Encoding options not available for a specific codec are now either greyed
out or hidden.
- Added "Autocrop" button in the "Filters" tab to calculate the best crop 
values for cutting away black borders and automatically fill the crop value 
fields. The analysis is done at the "checkpoint" min:sec position (default: 
00 min : 05 sec to avoid possible black screen at the beginning of the 
source). If the checkpoint is a black image or has incorrect borders, you 
should change the checkpoint value and click "Autocrop" again. Note: 
ffmpeg engine still consider crop values in Top/Bottom/Left/Right format, 
so the autocrop values are only correct for mencoder codecs.
- The mpeg-4 deinterlace option has been moved to the filters tab. Use 
"Preview" to check its effect before encoding.
- XviD deinterlacing is now enabled. Use "Preview" to check its effect 
before encoding.



- The "Split" tool has been moved to the "Filters" tab next to the "Preview" 
button, so as to allow preview of the split point before splitting. To split an 
avi or mpg file, define the split point in "Start from:", click "Preview" to 
check if the position is good, then hit the "Split" button.
- Added OCR components to convert subtitles from a VOB file into 
SubRip .srt subtitles text files. The OCR process using the gocr unix 
program is interactive and takes place in terminal (you will be asked to 
confirm recognition of some characters, and they will be added in a 
database). The process to convert DVD subtitles to .srt text files is the 
following: open a VOB file (must be located in a directory without spaces 
and special characters in the path!), define a destination basename with 
the "Save as.." dialog (set it inside a folder, so as to keep all the subtitle 
files together), then select ".srt" in the extract drop-down menu located in 
the "Filters" tab (the other option .idx will generate VobSub subtitles as 
introduced in version 0.0.6k), and then hit the "Extract" button. A series of
images will be generated for each title as well as their .txt version and a 
final .srt subtitle file. You can then delete the image and intermediate text 
files and keep only the .srt file. You should open the .srt file in a text editor
to correct any OCR mistakes. Use Mplayer OSX or ffmpegX to play the 
movie with the .srt subtitles added at playback time. You can also 
open .srt in TitleLab to convert them to Quicktime titles.
- Added ".SRT to DVD Studio Pro subtitles" converter tool (thanks Johan 
Lindström). Select a .srt subtitle in the Browse.. field and hit the button. 
This allow to import in DVD Studio Pro "Subtitle Editor" both VOB subtitles 
(converted via OCR as above) and widely available existing .srt subtitles.
- Added "Sub position" to define vertical position of text-based subtitles 
(.srt or other) added to mpeg-2 encodings (w/ "Use mplayer to decode" 
option enabled). Range is from 0 to 100. Use "Preview" to check the 
position and move subtitles interactively with keyboard controls R/T and 
find the right value to use. Note that image-based VobSub and DVD 
subtitles have their position set in the VOB and can't be moved with this 
control.
- Added optional "Angle" field in the Video tab to choose the angle to be 
encoded or previewed from multi-angle sources.
- Added "Play" button next to the "Open..." field to play source movie with 
selected audio track and subtitle file (.srt, .sub, .idx, etc) opened in the 
"Load subs" field and with subtitle color palette opened in the "Sub 
palette" field. In case of VOB playback, the "Title", "Chapter", "Angle" and 
"Subs" controls will also be active. Filters are also processed.
- Moved "Info" tool next to "Open.." field for quicker operation.
- New version of the engines installer (you must run it again in order to 
use 0.0.7), now displays a dialog to ask for the admin password without 
opening terminal, and should correctly handle spaces and special 
characters in filenames and path names.
- Added "Fix" tool. Use it to rebuild index of a corrupted .avi file, or to try 
fixing a corrupted .mpg file.
- Added "Author" tool to process a mpeg file with the authoring and split 
options on the left box (ie, split in N chunks, author as VCD, as SVCD or as
DVD).



- The Mux tool now always runs the author tool on the muxed mpeg file (if 
you don't want to author the file, disable the authoring and split 
checkboxes).
- The Join tool has been improved. Needs at least 2x-joined-files-size free 
disk space.
- Execution now totally stops when an error occurs.
- Disabled dvd device input for compliance to copyright laws (only non-
encrypted file input from the hard disk is supported). Functions like "Check
audio tracks" and "Check subtitles" will work with file input (eg. using a 
non-encrypted /VIDEO_TS/ folder as input, including generated by DVD 
Studio Pro and Sizzle).
- Updated to ffmpeg CVS of May 4, 2002.
- Online manual now available at http://homepage.mac.com/major4/

v0.0.6m May 1, 2003

- Added selection of image scaling algorithm in the Options tab (for 
mencoder DivX and XviD encoding). Choose the default "fast-bilinear" 
when speed is important. For better image quality but slower encoding, 
you can choose either Bicubic (best for upscaling), Bilinear (best for 
downscaling), Lanczos, or Bicubic spline (sharp picture).
- mencoder XviD and DivX engines are now able to correctly encode audio
from Quicktime movies in DV format. You should add a ".dv" extension to 
source filenames for proper handling.

v0.0.6L Apr 30, 2003

- The "Join" tool is now able to join two .avi files (encoded with same 
codecs, resolution and bitrate).
- "QT-decode" based encodings or with .mov sources are no longer forced 
to auto-letterboxing and will instead letterbox or simply resize according 
to setting of the "Letterbox" checkbox in the Options tab (thanks Johan 
Lindström).

v0.0.6k Apr 23, 2003

- Added "Extract" subtitles button in the Audio tab to extract subtitles in 
VobSub format without encoding (or re-encoding). Open the DVD or VOB 
file in the Open.. field, define subtitles destination basename in the Save 
as... field, choose subtitle number in the audio tab & hit "Extract". When 
extracting from DVD, you can also select start/end chapter numbers so as 
to generate subtitles for specific segments of the DVD title.
- Renumbered the audio track pulldown menu starting from track 0 in 
order to match subtitle numbering style and "Check" output numbering 
style ("audio stream #"). Please note, however, that if you're extracting 
audio track N in 0SEx, you will now need to select N-1 in the ffmpegX 



audio track menu.
- Improved audio tab layout.

v0.0.6j Apr 21, 2003

- When opening an input file, information about its file format, size & 
framerate is now automatically displayed above the input field.
- The 'Info' tool shows info about .avi and .mov files too and not only mpeg
files as before.
- Changed mpeg-2 NTSC presets from NTSC framerate to NTSC FILM 
framerate w/pulldown.

v0.0.6i Apr 20, 2003

- Added "File/Burn" pulldown menu for subtitles encoding (audio tab). 
When "Burn" is selected, subtitles are printed in the encoded video like in 
previous releases, however when "File" is selected, subtitles are 
extracted in VobSub format and saved to the output movie directory in
two files (.idx and .sub). The above applies while encoding to mencoder 
mpeg-4 or XviD codecs, either from a VOB containing subtitles, or direct 
from DVD.
- VobSub subtitles extracted as said above can now be printed in 
the image while encoding in mpeg-2 format with the "mplayer 
decode" options. Simply open the VobSub .idx file (or any other of the 
previously supported subtitles formats) in the "Load subs..." field prior to 
launching encoding. If you encode from direct-dvd there should not be any
color palette problems. If you encode from a VOB file, the subs could 
appear black. To correct this, locate the VTS_01_0.IFO file with the "Sub 
palette" button.
- The "View" tool can now play video with subtitles, including 
VobSub subtitles. Simply select the video file in the "Video.." field, and 
the subtitle file in the "Audio.." field (open the .idx file for VobSub 
subtitles), then select "View", then "Go!". If the color palette is wrong then
also locate a VTS_01_0.IFO file with the "Sub palette" button in the Audio 
tab. If you have a slow Mac, enter terminal while the movie is playing and 
type the following command to give more processor power to the video 
playback:

sudo renice -15 mplayer      (enter your admin password and
hit enter)
Also use the most recent possible version of the mplayer binary.
For reference here is a list of the main keyboard shortcuts available during
movie playback
                                  <- and ->                      seek      backward/forward   
10 seconds
                                  up and down                  seek      backward/forward   
1 minute
                                  pgup and pgdown          seek      backward/forward   



10 minutes
                                  p / SPACE                      pause movie (any key 
unpauses)
                                  q / ESC / ENTER                          stop playing
                                  + and -                          adjust audio    delay    by    
+/-0.1 second
                                  / and * (9 and 0)                          decrease/increase volume
                                  m                                      mute sound
                                  f                                      toggle fullscreen mode
                                  w and e                          decrease/increase 
panscan range
                                  o                                      toggle between on-screen 
stats: none / seek / seek+timer
                                  d                                      toggle frame dropping (for
slow machines)
                                  v                                      toggle subtitle 
visibility
                                  z and x                          adjust subtitle delay by +/-
0.1 second
                                  r and t                          adjust subtitle position
                                  g and y adjust to next / previous subtitle

v0.0.6h Apr 19, 2003

- mpeg-2 encoding with "mplayer decode" option activated now properly 
handles vbr encoding & minq settings.
- added "filesize" field to bitrate calculator to calculate bitrate to fit in a 
specific filesize in MB (Calc rate), or to calculate duration which can fit in a
specific filesize (Calc time).
- added "mp2" and "mp3" presets to encode audio only. Use as input a 
muxed video/audio file (VOB, MPG or AVI). If you use as input an audio-
only file (AC3, mp2, mp3, wav or other), then also check "Invert mapping" 
in the audio tab. Useful for fast audio conversions, ie VOB -> mp3, mp3 ->
mp2, etc. The mp3 encoding is based on the lame engine. The mp2 
encoding is based on the super-fast ffmpeg engine.

v0.0.6g Feb 15, 2003

- added "Subs palette" button in the audio tab to allow loading of VOB 
subtitles color palette from VTS_01_0.IFO file.
- added "Check audio track" and "Check subtitles" buttons to list audio 
tracks and subtitle languages found in the currently inserted DVD.
- the Split tool is now able to split both MPG files and AVI files to a min:sec 
splitpoint.
- MP3 audio bitrate is now correctly set for mencoder mpeg-4, DivX 3 and 
XviD.
- fixed some issues of mencoder missing audio with avi input.
- if you get "can't open libvorbis.0.dylib" error, download and install again 



the engines with the ffmpegX engines installer (new version of mencoder 
and mplayer has been put online today, thanks Devros).

v0.0.6f Feb 2, 2003

- Fixed some bugs from 0.0.6e (including an issue with NTSC material 
processed through "mplayer decode").
- AVI splitter now lets specify split point in minutes and seconds.
- Optimized bits per pixel calculator value for mpeg-4 codecs.

v0.0.6e Jan 26, 2003

- Added XviD encoding with full support of direct DVD encoding, crop and 
subtitles. NOTE: You need to install the newest version of the mencoder 
binary by downloading it from 
http://prdownloads.sourceforge.net/mplayerosx/lastbinary.sit and then 
using the enclosed ffmpegX engines installer.
- Active options for XviD encoding are bitrate, framerate, crop, resize, 4 
motion vectors, GOP and two-pass.
- Added XviD presets for PAL and NTSC.
- Enabled "Keep elementary streams" as default option in MPEG encoding.

v0.0.6d Jan 21, 2003

- Added encoding of SubRip, MicroDVD, SubRip, SubViewer, Sami, VPlayer,
RT, SSA, AQTitle,    JACOsub and MPsubt subtitles for converting AVI DivX 
into SVCD/CVD/DVD with subtitles (use "mplayer decode" and load the 
subtitle file with the "Load subs" button in the audio tab). Note you need 
to install a font set first from one of the included Subtitles installers. 
Choose the appropriate font set installer depending on the desired 
character encoding: "Subtitles iso-8859-1.pkg" is for Latin & Western 
Europe, "Subtitles iso-8859-2.pkg", "Subtitles iso-8859-7.pkg" and 
"Subtitles windows-1250.pkg" mostly used for east european languages 
(check http://www.w3.org/International/O-charset-lang.html for a list of 
languages typically associated to these character sets).
- DVD subtitles encoding now works for VOB->SVCD/CVD/DVD and not 
only direct-DVD->SVCD/CVD/DVD.
- DivX splitter slightly improved.

v0.0.6c Jan 20, 2003

- Added "Avi Split" tool. Select AVI DivX file, define a splitpoint in minutes 
and click "Go!". The two chunks will have a .part1.avi and .part2.avi 
extensions. Use it to burn in two CDs all those hi-res DivX files.
- Updated DivX presets for faster encoding.
- Fixed preview mode for mpeg-2 and mpeg-1 elementary streams.
- Other small bugfixes and GUI improvements.

v0.0.6b Jan 15, 2003



- Added display of start & end encoding time and date.
- Added "VIEW" tool, to playback divx or mpeg-1/2 files. Uses mplayer core
for playback. No more doctoring of DivX movies to fix the audio during 
playback. Set video file location, select "view" and click "GO!". Then 
toggle full-screen with Apple-F, pause with SPACE, arrows to forward-
rewind, and stop with RETURN.
- Added "Preview" button next to the "Save as.." destination name field. 
Use it to preview the output of ffmpegX while it is still encoding. Note in 
case of mpeg encoding only the video stream is played (no audio).
- Added "JOIN" tool to join two mpeg-1 or mpeg-2 files into one. Use the 
two fields to select path to the two files to join. Select "join" and click 
"GO!". The joined file will have a ".joined.mpg" extension.
- Some bugfixes from 0.0.6.

v0.0.6a Jan 14, 2003

- Added support of audio gain control for VOB -> MPEG-1/2 conversion 
(allowed values -96 to +96 dB).
- Some bugfixes from 0.0.6.

v0.0.6 Jan 12, 2003

- Updated to ffmpeg CVS of Jan 11, 2003, including faster Altivec 
optimizations.
- Added "mplayer decode" option for SVCD/DVD encoding. It will force use 
of mplayer to decode the input video, hopefully fixing NTSC audio sync 
problems like the "quicktime decode" option, but also allowing for direct 
DVD input and enabling subtitles (very slow for now, doesn't fully 
support .mov input but AVI, VOB, mpeg and direct DVD). You have now 
three methods to encode to SVCD/DVD. The first one, fastest, is activated 
by deselecting both "QT decode" and "mplayer decode", uses mpeg2dec 
or ffmpeg to decode and is suited to PAL material and non-variable 
framerate VOBs. The second one, activated with the "QT Decode" flag, is 
also pretty quick and uses Quicktime to decode, and solves most sync 
issues with NTSC material. The third one, activated with the "mplayer 
decode" flag, uses mplayer to decode, provides in addition subtitles 
encoding and direct DVD input but is real slow (like 4 times slower than 
encoding DVD to DivX with mencoder). It's probably worth using it only 
when SVCD subtitles are needed (also prefer 0SEx to direct DVD input so 
as to avoid keeping the DVD running for a long time). This option need 
install of mplayer (use the ffmpegX engines installer).
- Added the "ffmpegX engines installer" application. Use it to install the 
three external components doing the actual mpeg encoding and dvd 
reading (mpeg2enc, mencoder, mplayer). These components are not 
distributed with ffmpegX to comply with applicable laws and licensing 
terms and so they need to be downloaded from their distribution sites and
installed. Simply run the installer application once and follow the 
instructions. (Thanks ParaNox for the nice nicon).



- Includes a new version of movtoy4m fixing a bug which caused 
duplicated frames in .mov to VCD/SVCD conversion and decoding (thanks 
Johan Lindström).
- Added drop-down menu in the "Open.." field for selection of a disk device
name for DVD input.
- Added chapter start-end selection in the video tab, to allow encoding 
only part of a DVD or VOB title (useful e.g. to pre-split for multiple CD 
burning by encoding only half of the movie).
- Added verbose output when encoding 5 seconds test clip in DivX preset. 
This will print out:

- the crop values to be entered in the WHXY crop fields (check 
Terminal for the following output:

[cropdetect] Allocating mp_image_t, 
720x576x12bpp YUV planar, 622080 bytes

crop area: X: 11..716    Y: 75..501    (-vop 
crop=704:426:12:76)

    the values to be entered are the four numbers following -vop
crop (704, 426, 12, 76 in this case)

- (DVD input) the list of available subtitle languages and their 
ID number

[open] subtitle ( sid ): 0 language: en
[open] subtitle ( sid ): 1 language: fr
[open] subtitle ( sid ): 2 language: nl
[open] subtitle ( sid ): 3 language: ar

    the value to be entered in the "Encode Subtitles #" field (in 
the audio tab) is the number 0-N
        following (sid): in the list. For input from a VOB ripped with 
0SEx, the value to be entered is 

    the one shown by 0SEx for the subtitle track included in the 
VOB less 1, eg if you ripped 

    subtitle 3 you must set "Encode subtitles #" to 2.
- (DVD input) the list of available audio language streams and 

their ID numbers:
[open] audio stream: 0 audio format: ac3 

(5.1) language: en aid: 128
[open] audio stream: 1 audio format: ac3 

(5.1) language: fr aid: 129
[open] number of audio channels on disk: 2.

    the value to be entered in the "Audio track" field is 1-N in 
the order of the available streams.

    For input from a VOB ripped with 0SEx, the "Audio track" 
value is the one shown by 0SEx for the

    audio track included in the VOB, eg if you ripped stream 2 
you must set "Audio track" to 2.
- The "Encode 5 seconds test clip" starts from minute 1:00 of playing to 
avoid initial black or title image with incorrect crop size.
- SVCD and VCD authoring now also generates the .toc file (needed if you 
burn with MMB instead of Toast).



v0.0.5 Jan 5, 2003

- Added mencoder encoding engine. Though a little slower than ffmpeg, it 
fixes all sync problems on VOB->DivX NTSC and PAL and allows for direct 
DVD input. Only mp3 audio encoding is available (however by selecting 
"Passthrough" the original audio (.ac3 or .mp2) can be directly copied into 
the encoded file if needed). Encoding options works with the same values 
as ffmpeg encoder.
- In order for ffmpegX to comply with applicable laws and licenses, we 
don't distribute the mencoder component. You need to install yourself the 
mencoder binary into /usr/bin/ by using the following terminal commands 
(an installer will be included in next versions to simplify this one-time 
step):

- copy the mencoder binary available from 
http://sourceforge.net/projects/mplayerosx/ into your desktop (the 
current latest binary is 0.9rc2b3 in the package mencoderrc3.sit - 
decompress it, ctrl-click the 'Mencoder for OSX' app icon, choose the open
package option and look into Contents/Resources folder for the 
"mencoder" file).

-use the following commands in terminal mode (copy and 
paste them, line by line):

sudo cp ~/Desktop/mencoder /usr/bin/mencoder
sudo chmod 755 /usr/bin/mencoder
rehash

- "DivX" presets now use mencoder. ffmpeg DivX presets have been 
renamed "fast DivX".
- Mencoder DivX preset can directly read from DVD. No more need for the 
0SEx step and lot of disk space. Simply type your DVD device name in the 
Open... field, ie. /dev/rdisk1 (or rdisk2, rdisk3... depending on your DVD 
device name is; to know it, insert a DVD, then open Terminal, type mount 
and it will be listed amongst all disk devices available. Note it will be listed
in the form /dev/disk1 while you must enter /dev/rdisk1). Simply type 
/dev/rdisk1 in the ffmpegX Open.. field and you will be able to launch 
direct encoding from DVD. If you have problems ejecting the DVD when 
encoding is done, you could try to open Toast and use the Eject command.
- Added DVD Title number field in the video tab. If encoding direct from 
DVD, it selects the title number (i.e. sometimes Title 1 is a trailer, title 2 
the movie, etc).
- Added subtitles encoding for DivX preset. You need to specify the subtitle
number 0..31 (note: the audio language is choosen as usual with the 
audio "Track" pulldown menu). The subs will be directly overlayed in the 
encoded image.
- mencoder image cropping values are in the form WHXY (cropped image 
width, height, and x,y position of the cropped image counted from the 
upper left corner of the source image). By running an "Encode 5 seconds 
test clip" the Terminal will automatically detect black borders and tell you 
which values you should enter for WHXY (the ffmpeg cropping values still 



follow the old TBLR top/bottom/left/right method, sorry for the GUI not 
telling this right now).
- Added "Encode 5 seconds test clip" for mencoder DivX encoding. Useful 
to check the title being encoded and the cropping values.
- Added audio gain setting in the audio tab (right now works only with 
mencoder engine). Allowed range is 0-10. Default is 0 (keep volume the 
same as the source with no gain applied).
- Added "QT Decode" option for VCD/SVCD/DVD encoding. It will force use 
of Quicktime to decode the input video, fixing almost all NTSC audio sync 
problems. It also decodes audio automatically. If the input file is mpeg-2 or
VOB you also need to have installed the Quicktime mpeg-2 player 
component (available from Apple Store).
- When encoding .mov DV files to another format, the "single field" 
Quicktime flag is automatically set.
- You can now encode DV to VCD/SVCD/CVD/DVD by using the ffmpeg DV 
decoder instead of Quicktime, this leads to better image quality and 
correct colorspace. To do it, rename your movie with a ".dv" file extension 
instead of .mov (this was not working correctly in previous versions for 
audio decoding but has now been fixed). You should also disable "VOB 
Letterbox", "Denoise" and "Bicubic scaling". You can use "Deinterlace" if 
you like. For DV to DivX, the new mencoder DivX preset full supports it 
with same results.
- Added experimental support of .mov input for ffmpeg DivX and fast-
mpeg1 encoding (video only, or need audio as separate file added in the 
"Add audio" tab).
- Various GUI improvements. There is now only one tab for all encoding 
options, which change dynamically depending on the video codec 
selected so as only the relevant options do appear for any given process.

v0.0.4k Jan 3, 2003

- Added "Author as DVD" post-processing option, to create mini-DVD and 
DVD. It will create both a "DVD" folder burnable in Toast DVD mode, and a 
DVD image in UDF format burnable with Disk Copy app, or with Toast "disk
image" mode. Before burning, preview the DVD folder and its audio sync 
by opening the "VIDEO_TS" folder in the Apple DVD Player application (hit 
"play" after opening).
- Added presets for high-bitrate DVD encoding (about 2 hours video in a 
4GB DVD) and low-bitrate DVD encoding (uses half D1 image size for more
than 3.5 hours video in a 4GB DVD). Eg. paste two .mov divx movies (or 
many DV files) together in quicktime player, then turn them into one DVD 
by using the low-bitrate DVD encoding preset.
- The Tools now allow to create a DVD from existing mpeg video streams 
and audio files (mp2, ac3 or others which will be converted into mp2). Set 
"mux as DVD", "postprocess", "author as DVD", "Go!".
- Added "DVD" encoding profile in the VCD/SVCD tab.
- Added new calculator button "Calc time" to calculate how much minutes 
will fit in specified number of CDs with current video & audio bitrate 
values. Example 1: set preset=CVD PAL, media=DVD 4GB, CD=1 and click



"Calc time", you'll learn that a DVD 4GB can hold 219 minutes of CVD 
video. Example 2: set preset=SVCD NTSC, media=3 CDs 80 min mode-2 
and click "Calc time", you'll know that those 3 CDs can hold 119 minutes 
of SVCD video.
- Disabled the "close" window control upon user requests.

v0.0.4j Jan 2, 2003

- Added presets for CVD encoding (a CVD is similar to a SVCD but uses a 
smaller image size of 352x480 for NTSC and 352x576 for PAL, which is 
equal to the SVHS resolution and looks very good). Most DVD players 
(especially PAL ones) are CVD compatible. Also the mpeg-2 streams in this
size are accepted by most DVD authoring programs, including DVD Studio 
Pro, as 1/2D1 sized material. CVDs are authored and burned like SVCDs.

v0.0.4i Dec 31, 2002

- Added sharpness control for VCD and SVCD encoding (note: denoise 
must also be checked). Allowed values are from 0 to 255% (default: 
125%). Do not set too high as it will increase bit-noise.
- Added "Info" tool to display information about elementary mpeg video or
audio files (.m1v, .m2v, .mpv, .mpa, .mp2, .mp3).
- The "Mux as.." tool will normally convert non-mp2 audio sources to mp2 
before muxing (i.e. you're muxing for VCD/SVCD), however if the audio file
is in AC3 format and has an ".ac3" file extension, it will be muxed as AC3 
without conversion (i.e. you're muxing for DVD).
- Added "Unspecified" video framerate value (will use same value as 
source). Can be used only when encoding to DivX or fast MPEG-1 (not 
MPEG-1 VCD or MPEG-2).
- Added "GOP Headers" checkbox in the VCD/SVCD tab to insert a 
sequence header at the start of every GOP.    This should only be used if 
your player need it to support fast forward/rewind.
- The image size fields are always enabled to allow to input changes even 
while using preset autosize values.
- The dialog sheet "Processing has been launched in background on a new 
terminal window" has been removed. No more icon bouncing in the dock.

v0.0.4h Dec 26, 2002

- Updated to ffmpeg CVS of Dec 26, 2002.
- Fixed bug of stuttering video when decoding VOB to DivX or to fast-
mpeg1.
- Added luminance contrast and saturation (chrominance contrast) 
controls for VCD and SVCD encoding (note: denoise must also be 
checked). Allowed values are from 0 to 255.
- VCD and SVCD encoding have now a new deinterlace method available 
(check both "deinterlace" and "denoise" to enable it), it leads to much 
better results with DV video.
- Denoise filter is now forced to pass II mode only (faster, but intended for 



low noise material).
- The "Mux as.." tool now also accept audio input in WAV, AC3, mp3 or 
other formats (and will convert them to MP2). Tip: you can now use the 
Apple MPEG-2 encoder and quickly make a SVCD in one click. Use 
Quicktime player pro to export your video as MPEG-2 (bitrate 2.5 Mbps), 
then export separately the audio as WAV file. Open resulting audio and 
video files in the "Mux as.." tool and enable "Postprocess". Set "Split" as 
needed and "Author" as SVCD. Finally click "Go!" and you'll obtain your 
SVCD disk images. Note: this is not really a SVCD as it uses a non 
standard image size, so not all DVD players will play it.
- When using the bitrate calculator to calculate a new bitrate for SVCD or 
VCD, profile is automatically set to XSVCD or XVCD.
- Added DVD 4GB media in the bitrate calculator.

v 0.0.4g Nov 2, 2002

- Updated to ffmpeg CVS of 2 nov 2002 with all libs and Altivec-optimized 
mpeg-1 encoding (20% faster than realtime, however still choppy, so use 
the new mpeg-1 VCD format for now).
- Added new "MPEG-1 VCD" format. It is similar to old MPEG-1 format (still 
available in the dropdown menu, and in the presets as "fast mpeg-1"), but
mjpegtools components are used to encode instead of ffmpeg, leading (for
the current version) to a fully compliant stream for CBR VCD and VBR 
XVCD authoring and playback on a compatible DVD player. "mpeg-1 VCD" 
files can be dropped directly on Toast without pre-authoring. Input formats
can be Quicktime MOV in all codecs, VOB, and the usual ffmpeg input 
formats. Decoding and encoding are Altivec optimized and VOB->VCD 
encodes now in realtime on a G4 667.
- The mpeg-1 VCD & XSVCD presets will now use the new MPEG-1 VCD 
format. The encoding options must be set in the new "VCD/SVCD" tab 
(bicubic scaling, letterboxing, etc are now all functional for VCD too). 
XSVCD mpeg-1 need post-processing "Author as VCD" before burning with
Toast, while VCD mpeg-1 can be directly burned on Toast. The splitter is 
also fully functional for automatic multiple disk VCD authoring.
- When using the old MPEG-1 format, the options are still in the MPEG-1/4 
tab. 
- Added CBR encoding option for mpeg-2 and "mpeg-1 VCD". CBR is 
needed to create a perfectly compliant VCD mpeg-1 stream which will 
play on all compatible DVD players and will be accepted by Toast directly. 
However if your player can handle VBR, it should be preferred, as it will 
lead to constant quality streams and, with a proper quantizer setting, 
possibly smaller files. If you only plan to playback the streams on a 
computer there is no point in preferring CBR over VBR.
- Added new VCD, XVCD, and generic MPEG-1 profiles in the VCD/SVCD 
tab.
- When encoding a VOB to mpeg-2 or mpeg-1 VCD you can rename the 
VOB with a ".mov" extension, that way use of Quicktime will be forced to 
decode it (possibly leading to better audio sync), however audio must be 
decoded separately into WAV and put in the same folder and with the 



same filename before launching the video encoding, so as ffmpegX will 
pick it and mux with the encoded video.
- Added DVD NTSC and DVD PAL (including 16:9) in the Autosize 
dropdown. Useful to encode to mpeg-2 with the proper aspect ratio flag 
settings, for later use of elementary streams for DVD authoring.

v 0.0.4f Oct 31, 2002

- Updated to ffmpeg CVS of 31 oct 2002 with all libs.
- Added "Passthrough" in the video codec and audio codec dropdowns 
which will copy the video or audio stream directly to the output file. Works
only with AVI containers in output. Useful to change AVI files with WMA 
audio into MP3 without reencoding video, just remuxing it.
- To address insisting request, added "Echo command line" option in the 
Tools tab. It will echo the command line directly to Terminal -when 
possible- (there are cases when it is not) so you'll enjoy again the ability of
stopping the encode with the "q" key.

v 0.0.4e Oct 29, 2002

- Updated to ffmpeg CVS of 28 oct 2002.
- Better handling of .mov container input (ie can now convert DV 
video .mov to DivX, just export first the sound as WAV and "Add" it in the 
Audio tab), better video/audio sync and WMA audio decoding.
- The new mpeg-1 "VCD" muxer has still issues and the mpeg-1 streams 
can play choppy. Try qmin=qmax and mpeg-1 "2-pass" encoding.
- New version of the splitter works FAR better on mpeg-2 split, though in 
some cases the 1st chunk can be shortened at authoring step.
- Added calculator presets for 90 min and 99 min CD media.
- The Mpeg Tools "Mux as.." function will use the Audio Sync ms value 
specified in the mpeg-2 options tab.
- Multiple parallel 2-pass encoding processes are now allowed.

v 0.0.4d Oct 10, 2002

- Updated to ffmpeg CVS of 11 oct 2002.
- Added DivX and MPEG-1 "Two-pass encoding" option in the mpeg1/4 
options tab. (In this version, don't run more than one encoding in parallel 
when using two-pass or you will obtain a segfault).
- ffmpeg now support DV video input in AVI container (audio & video) 
or .dv stream (audio only).
- Added new postprocessing option "Keep elementary streams" which 
when encoding mpeg-2 will keep both elementary audio/video streams 
and the muxed stream. Requires 2x disk space. Needed if you want to 
remux the elementary streams later or import them in other programs.
- Added MPEG Tools to process MPEG files without encoding. Open either a
.m2v, .m1v or .mpv elementary video stream and a .mpa, .mp2 audio 
stream, or just a .mpg muxed video & audio stream. Then you can either: 



a) "Mux" to mux elementary video & audio by using the 
selected profile (available profiles: SVCD, XSVCD, DVD, MPEG-2 (generic), 
VCD, XVCD, MPEG-1 (generic), 

b) "Postprocess" to apply the postprocessing options: split in N
chunks and author as SVCD or VCD, 

c) "Demux" to demux the muxed video & audio into 
elementary streams.
Example #1. You've got a .m2v video file encoded with the Quicktime 
MPEG-2 encoder at 2,5M bitrate. You exported the sound as a .mp2 file. 
Open both files in the MPEG Tools view, check "Author as SVCD", "Split in 
3 chunks", "Mux as SVCD", "Postprocess" & click on "Go!". You'll get ready-
to burn SVCDs multiple CD sets.
Example #2. You have got a mpeg-1 muxed file which is too big to fit on 
a CD and you want to split it in 2 chunks. Open it in the MPEG Tools (leave 
audio field blank). Check "Split in 2 chunks", "Postprocess" (and eventually
"Author as VCD" if you like) and click "Go!".
Example #3. You want to revert a .MPG muxed file into its elementary 
streams (separate .mpv video and .mpa audio files). Open the .mpg file in 
the MPEG Tools (leave audio field blank). Check "Demux" and click "Go!".
- Note : the splitter is still in "wild-alpha", that means, very often the split 
will not work. A fix is being worked on.
- Bitrate calculator now let you choose 74 min and 80 min media either 
burned in mode-1 (with error correction, less space for data, best for DivX)
or mode-2 (no error correction, more space for data, for VCD/SVCD).

v 0.0.4c intermediate release

v 0.0.4b Oct 5, 2002

- Added mpeg-2 SVCD encoding. Input files for mpeg-2 encoding can be 
VOB, Quicktime .MOV, and all usual ffmpeg input formats. Quicktime input
need use of Quicktime 6.    Quicktime movies will be automatically 
letterboxed with black bars to fit in 4:3 or 16:9 TV ratios.
- VOB to mpeg-2 encodes sound in Dolby Surround.
- mpeg-2 SVCD presets added in the Quick presets menu.
- "mpeg-2 options" tab: mpeg-2 profiles selector (standard SVCD=bitrate 
is forced to 2500, XSVCD=user bitrate, generic mpeg-2), multithreading 
for dual processor G4, add 3:2 pulldown, undo 3:2 pulldown (revert to 
original frames from NTSC movies 3:2 pulled down), deinterlace (before 
encoding), process black & white video, letterbox anamorphic 16:9 VOB 
for playback on 4:3 TV, denoise (apply a lowpass filter to reduce noise of 
captured sources), use high-quality bicubic scaling algorithm, enable 
Altivec for fast VOB decoding.
- Automatic SVCD authoring is obtained by selecting "author as SVCD" in 
the postprocessing tab. This way you can go straight from a Quicktime 
movie, a VOB or a DivX movie to the two ".IMG" files ready to be burned in
Toast XA multitrack mode for creating a fully compliant SVCD.
- Postprocessing "split" function for multiple CD burning (multiple couples 
of .IMG files will then be authored). An 80-min CD holds average 40 



minutes of SVCD video, so choose the appropriate number of chunks 
depending on the duration of your source material.
- mpeg-2 audio sync control delays video by entering a time delay in 
milliseconds.
- mpeg-2 encoding relies on mpeg2enc from 
http://mjpeg.sourceforge.net/MacOS/ which must be copied first 
into /usr/bin as the binary is not included into the package (to comply 
with mpeg licensing issues). The current 1.7.0 version has been Altivec 
optimized so it encodes SVCD in about 3.5 times the duration of the 
source material on a G4 667 (1 minute is encoded in 3 and half minutes). 
To copy the binary into /usr/bin which is invisible through the Fnder, you 
should copy it first into your Home folder, then use the following 
commands in terminal mode (copy and paste them, line by line):

sudo cp ~/mpeg2enc /usr/bin/mpeg2enc
sudo chmod 755 /usr/bin/mpeg2enc
rehash

- Quiet terminal window output. When the encoding and postprocessing 
are completed, a message "Encoding complete" is now printed on 
terminal.
- Updated ffmpeg to latest CVS including faster processing and many 
fixes.
- Support for ogg vorbis audio format.
- If for a wild reason you need to abort the encode, press apple-dot or 
apple-shift-dot on the terminal window.
- New and more self-explanatory GUI for the mpeg-1/4 variable quantizers.
- VBV buffer size value autofix for mpeg-1 encoding.
- Crop is not active with VOB/.MOV to mpeg-2.
- Hint : in the case of .MOV to mpeg-2, the Quicktime Player info panel can
be used to manipulate the source as needed, e.g. adding subtitles, filters, 
or activating the 'high quality' flag or "frame only" for converting DV 
interlaced sources, etc. After applying the changes, save a new .mov with 
dependancies and encode it into SVCD.
- Hint : the best method to convert AVI Divx into SVCD is now to feed 
the .avi file to Divx Doctor II and then encode the .mov container instead 
of directly the .avi.
- Groovy metallized GUI (Jaguar-only) instigated by PowerMacG4.
- Bundled ffmpegX icons pack by ParaNox.
- Known issues : 1/ mpeg-2 encoding forces mp2 audio (no ac3 for now). 
2/ mpeg-2 video only or audio only are currently not implemented. 3/ The 
splitter is still in alpha version.
- Thanks the ffmpeg and mjpegtools crews; James Klicman for the latest 
Altivec optimizations to mpeg2enc; Lordrpi for patching mpeg2dec with 
the Altivec optimizations and all compiles; Johan Lindström for the 
Quicktime to yuv4mpg code; Henri Mason for patching the yuv4mpg code 
to ffmpeg, fixing VBV value for mpeg-1, and support; Philipp Biermann for 
the mpeg split mods to handle muxed streams and mpeg-2.

v 0.0.3c Aug 29, 2002



- added cropping support (thanks to latest code and builds by Antoine 
Duchateau, Henry Mason and Justin F. Hallett)
- added localizations in French (thanks gorgar), Italian (thanks 
the_pappardella), and Japanese (thanks Yoshiki Hiraki)

v 0.0.3 Aug 9, 2002

- tested under OSX.2 Jaguar. If you use it under OSX.1 and get the error 
"NSReceiverEvaluationScriptError" when opening a file then you must 
install this update : 
http://www.versiontracker.com/moreinfo.fcgi?id=15315&db=mac
- added Mpeg-1 post-processing option "Split in N chunks". It will split the 
encoded file into 2, 3 or 4 chunks for burning to multiple CDs (if post 
processing to XSVCD or XVCD is activated, multiple sets of .bin/.cue 
or .img files will be equally authored). How many chunks/CDs are needed 
depends upon the source duration and the video and audio bitrate used 
for encoding. By using the recommended video bitrate of 2000 and audio 
bitrate of 128 (XSVCD preset), about 50 minutes of video can be packed in
one 80 min CD (so 100 minutes in two CDs, 150 minutes in three CDs), or 
45 minutes in a 74 min CD (so 90 min in two CDs, 135 min in three CDs). 
If you use different settings, use the built-in bitrate calculator: enter your 
movie duration in minutes, enter how many CDs you want the movie to fit 
in, specify if it is 74 min or 80 min media, and click "Calculate" to find 
which video bitrate you should use. Please note if you modify quantizers 
to force VBR, the calculator will not be reliable. Thanks to Philipp 
Biermann for coding a modified version of mpegsplit/mpgtx handling 
correctly muxed streams headers & applying a timecode fix.
- When encoding opendivx sources to mpeg1, the resulting stream may 
show an incorrect duration in Quicktime Player (i.e. 6x the real duration), 
or begin with blank frames and not play on a DVD player.    To try to fix 
these problems you should use the postprocessing option to "Split in N 
chunks" which will split, but also fix the stream. If you don't want to split 
there is a "Split in 1 chunks" option which will still apply the fix.
- added "Quick Presets" drop-down fo 'one-click' encoding. Set input and 
output file, choose a Quick preset & hit Encode. Current choices are VOB 
to DivX, VOB or DivX to VCD (including autosplitting on 2 CDs and 
authoring of .bin Toast-ready files), and VOB or DivX into high quality 
XSVCD (2Mbps MPG1 streams) including autosplit on 3 CDs and authoring 
of 01.img/02.img files to be burned using Toast in XA multitrack mode. You
should still check the audio sampling rate and video framerate of your 
source material and use the same values for encoding, in order to 
minimize audio sync problems.
- added Mpeg-1 post-processing option "Create XSVCD" to author the 
encoded mpeg-1 file as XSVCD (SVCD 1.0 filesystem but with a mpeg-1 
stream instead of mpeg-2, it will work on many DVD players supporting 
SVCD). The output will be movie.mpg_01.img & movie.mpg_02.img (in 
multiple sets if split activated). Burn by dropping both files in the XA multi-
track window of Toast.
- added Mpeg-1 post-processing option "Create XVCD". It will author the 



encoded mpg file as XVCD (VCD 2.0    filesystem). The output will be 
movie.bin / movie.cue (in multiple sets if split activates). Burn either by 
opening movie.cue on cdrdao, or by dropping movie.bin only on the VIDEO
CD option window of Toast.
- added an additional video bitrate calculator using "bits per pixels", 
gknot-style formula (thanks PowerMacG4 for reverse engineering it). Enter
your image size and framerate and click Calculate. It will calculate the 
optimal video bitrate for best image quality. Values are accurate for Divx 3
and MPG-1 encoding.
- added "Add audio" button in the Audio settings to add a separate audio 
file so it is now possible to encode DivX or MPG from two separate video 
and audio inputs, like .asf and .wav, or .m2v and .m2a.
- added 'Invert mapping' checkbox in Audio settings tab to deal with input 
files with inverted audio & video, i.e. the video being mapped as 1 instead
of 0 and the audio as 0 instead of N. You can see if it is the case by looking
at the Terminal window mapping output after getting an error (you are 
trying to encode video into audio & audio into video). In that case, simply 
check this box to invert the mapping and hit Encode again.
- Input and output files fields are now also editable so you can change a 
filename quicker or copy and paste the input field to the output field and 
add just the .avi or .mpg extension.
- fixed a parameter bug which prevented 0.0.2 to encode audio only from 
multiplexed sources. You can now launch a blazing-fast VOB -> MP2 
encode by disabling the "Encode video" checkbox.
- set audio sampling rate default to 48Khz (this value should always be 
used with VOB sources to minimize audio sync problems, Divx sources 
may be either 48 or 44.1 Khz).
- Use Apple-Shift-. on terminal window to abort encoding.
- Added autosize settings for VCD and SVCD PAL & NTSC standard sizes.
- Default GOP size is set to 12 for MPEG1 encoding and 240 for DivX 
encoding.
- Packed vcdxgen and vcdxbuild for authoring to VCD/SVCD.
- Aquafied icon by Justin Woods.

v 0.0.2 July 2002
- Various GUI fixes.
- New defaults for advanced settings tab (and new quantizer defaults).
- Added combo boxes for audio bitrate, audio sampling rate, video 
framerate.
- Leaving size fields blank will default them to 640x352. Leaving audio 
bitrate and audio sampling rate blank will default them to 128 kbps and 
44100 Hz.
- Added Audio settings > Track to select the source audio track to be 
encoded (to be used in case of multitrack audio source material).
- Set MPEG-1 format to ISO packet size output for VCD use.
- Video bitrate calculator correctly handles case of video encoding only (ie 
when "Encode audio" is not checked).
- New 'Post-processing' tab allows for additional processing to be done on 



encoded output. Current available options is turning a mpeg1 file into a 
VCD image (compatible with Toast Video CD mode and with cdrdao).
- vcdgear 1.6 by Dracore has been packed in for mpg2bin conversion.
- French GUI translation by gorgar. Italian GUI translation by 
the_pappardella
- New icon by Justin Woods.
- Thanks to Henri Mason for collaboration & support.

v 0.0.1a June 2002
First release.


